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Only works in Barcode Image Maker Pro v3.40 or better.

You can also use Code Barcode Maker Pro v3.40 or better, Retail Barcode Maker Pro v3.40 (please
note Code 39 is not supported), Barcode Maker v7.40 or better.

| am going to show how to have three columns and 3 labels and then data merge barcode images and

also data merge text above the barcode. Let’s get started. Barcode software used is Barcode Image
Maker Pro.

Make Sequence

Click on the Sequential TAB in Barcode Image Maker Pro (Download here)
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Sequential [NUM1]
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Stop 95
Step
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Add leading feros to Start

| Clear |

The sequence, for the first barcodes are 000 to 099. Please fill in Start: 0 and Stop: 99, we do not
need to fill in anything in Step as we are going to use one. Make sure Digits have been selected in the
combo box and also ‘Add leading Zeros to Start’ should be checked. Please look at the above image.



Select Barcode

Code 359 -
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Hyphen
Control Char

[MUM1] [NUMZ] or [ADV] Sequence
O[NUM1]

Clear Barcode List before adding sequential
[ Add to Sequentail List

Make Sequential

Code 39 has been selected as the barcode to use in Select Barcode. As we only have two digits in the
Sequence [NUM1] and wants three. Fill in O[NUMZ1] (Right click is also possible) in [NUM1][NUM2] or
[ADV] Sequence, this will make 000 to 099. Check ‘Clear Barcode List before adding sequential’. To

add the sequence to the barcode list, click on the Make Sequential button. Please look at the above
image.
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Please click on the Barcode Tab. Please look at the above image.
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This is the Barcode List, the barcode sequence have been added. Please look at the above image.
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| have clicked on the first entry in the Barcode List, the barcode image is shown to the right. As you
can see there are 4 digits, we wanted 3, the last digit is the checksum. Please look at the above

image.
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To remove the checksum, click on the Barcode menu and then go to Calculate Checksum, click on No.
The checksum will not be calculated and shown in the barcode image. Please look at the above
image.
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As we are going to add some text above the barcode, we do not need the human readable text below
the barcode, so let’s remove it. Click on the Barcode menu and then go to Human readable text
alignment, please click on None. The digits below the barcode will be removed. Please look at the
above image.
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As you can see in the barcode image to the right, we have no digits. Let’s save the first sequence of
barcode images. Please look at the above image.
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In the Barcode List, click on the Right mouse button and then click on Check all Iltems. All items in the
Barcode List will be checked and can now be saved as an image. Please look at the above image.
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Click on the Save as icon in the Toolbar. Please look at the above image.



. 3 Labels one barcode each in InDesign

We need to make a folder. | will make the one shown above. To make things a bit easier | will add a
Sub Folder. Please look at the above image.

. Labell

Open the folder you have already made (3 Labels one barcode each in InDesign) and then make a Sub
Folder, named Labell. Make sure you have opened the sub folder, Labell.

Fill in anything as the File Name. Select the file format you would like to save the barcodes as, | will
be using Encapsulated PostScript *.eps. Click on the Save button to save all barcode images in the

Labell sub folder. When you have saved the barcode images, then let's make the next sequence.
Please look at the above image.

[NUMT] [MUMZ] or [ADV] Sequence
1[NUMA1]

4 Clear Barcode List before adding sequertial
7] Add to Sequentail List

Make Sequential

Leave Sequence [NUM1] as it is. Fill in 1[NUM1] in [NUM1][NUM2] or [ADV] Sequence, this will make
100 to 199. Check ‘Clear Barcode List before adding sequential’. To add the sequence to the barcode
list, click on the Make Sequential button. Please look at the above image.

When the message box shows, ‘Clear Barcode List ?’, click on Yes.
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In the Barcode List, click on the Right mouse button and then click on Check all Items. All items in the
Barcode List will be checked and can now be saved as an image. Please look at the above image.
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Click on the Save as icon in the Toolbar. Please look at the above image.
| Label2

Open the folder you have already made (3 Labels one barcode each in InDesign) and then make a Sub
Folder, named Label2. Make sure you have opened the sub folder, Label2.

Fill in anything as the File Name. Select the file format you would like to save the barcodes as, | will
be using Encapsulated PostScript *.eps. Click on the Save button to save all barcode images in the
Label2 sub folder. When you have saved the barcode images, then let's make the next sequence.
Please look at the above image.



[NUMT] [MUMZ] or [ADV] Sequence
ZNUMT

Clear Barcode List before adding sequertial
] Add to Sequentail List

Make Sequential

Leave Sequence [NUM1] as it is. Fill in 2[NUM1] in [NUM1][NUM2] or [ADV] Sequence, this will make
200 to 299. Check ‘Clear Barcode List before adding sequential’. To add the sequence to the barcode
list, click on the Make Sequential button. Please look at the above image.

When the message box shows, ‘Clear Barcode List ?’, click on Yes.
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In the Barcode List, click on the Right mouse button and then click on Check all Items. All items in the
Barcode List will be checked and can now be saved as an image.

Click on the Save as icon in the Toolbar.



. Label3

Open the folder you have already made (3 Labels one barcode each in InDesign) and then make a Sub

Folder, named Label3. Make sure you have opened the sub folder, Label3. Please look at the above
image.

Fill in anything as the File Name. Select the file format you would like to save the barcodes as, | will
be using Encapsulated PostScript *.eps. Click on the Save button to save all barcode images in the
Label3 sub folder. When you have saved the barcode images, and then let's make the next sequence.
Please look at the above image.
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Cut
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Paste i

In the area Text in the Panel fill in No. [MSEQ], In Free Text, click on the right mouse button and then
click on ‘Add Make Sequential [MSEQ]'.

What the above does is adding the file name, in this case _000.eps as text, e.g. _000.eps is going to
be No. 000 and make the txtLabell to the text file for InDesign when saved . All files and Sub Folders
will be added. E.g. txtLabell, txtLabel2, txtLabel3. Please look at the above image
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| Comma Delimited text file (*.bd) for Adobe InDesign

Save As
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When we have saved the barcode images, then it's time to Export the Comma Delimited text file (*.txt)

Product

Comma Delimited text file (*.bd) » Scan Folder

Add barcode image in M5 Excel Scan Folder/Sub Folders

Windows register settings ick found item

for Adobe InDesign, click on the Save As. Please look at the above image.
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Browser for Folder will show, click on the folder that contains the sub folder, in this case 3 Labels on
barcode each in InDesign, then please click on the OK button. Please look at the above image.




Now you will have to fill in a File name for the Comma Delimited text file (*.txt) for Adobe InDesign, |
have filled in 3 Labels one barcode each in InDesign
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When the above dialog windows shows (Adobe InDesign CS4), select Document, or any format you
would like to use for the sequential bar coding or if you have already made a design then just Open it.
Please look at the above image.
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Document Preset: [Custom] - | oK |
Number of Pages: |1 [¥] Facing Pages [ Cancel |
[ Master Text Frame

[ Save Preset... ]
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Width: 7210 mm Orientation: E
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Margins
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| have selected a A4 document, but any other size would work. In Columns Number: 3 and fill in
Gutter: 0 mm, other settings have not been changed (12.7 mm = 0,5 In) Click on the OK button.
Please look at the above image.




In the above image you can see the page that we have defined, 3 columns, no gutters. Please look at
the above image.
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We are going to use the same size for all the labels, so we only need to make one for each column
and the rest will be added automatically by InDesign. Click on the Rectangle Tool as shown in the
image above.




The first label have been added using the Rectangle Tool(M). Please look at the above image.
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This is the size (W and H) and placement (X and Y) of the first label (rectangle). Please look at the
above image.
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Make sure that the first label (rectangle) have been selected, click on the Edit menu and then click on
Copy to copy the Label (Rectangle). Please look at the above image.
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Click on the Edit menu and then click on Paste to get a new label (Rectangle). Please look at the
above image.
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{ Selection Tool (V, Escape)

Click on the Selection Tool (V, Escape) to be able to move the label (rectangle) that we pasted in
InDesign. Please look at the above image.
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Move the label (rectangle) to right of the first label (rectangle). Please look at the above image.
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Click on the Edit menu and then click on Paste to get a new label (Rectangle). Please look at the
above image.
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[ Selection Toel [V, Escape)

Click on the Selection Tool (V, Escape) to be able to move the label (rectangle) that we pasted in
InDesign. Please look at the above image.
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Move the label (rectangle) to right of the second label (rectangle). Now we have three labels
(rectangles). Please look at the above image.

Add arectangle frame

2

o

Rectangle Frame Tool (F)

——

The barcodes and text above the barcode will be placed in a Rectangle Frame, so please select the
'Rectangle Frame Tool (F)' in Adobe InDesign. Please look at the above image.

Please add the first Rectangle Frame for the barcode image on the first label (rectangle) as shown in
the above image.
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This is the size (W and H) and placement (X and Y) of the first label (rectangle). Please look at the
above image. Please Copy and Paste the Rectangle Frame and place one on the Label in the center
and one in the label to the right.

Please add the first Rectangle Frame for the text above the barcode on the first label (rectangle) as
shown in the above image

i 43,467 mm W 48,667 mm

ﬁEE vi 22286 mm | B[ B0sdmm |

X:43.667 mm =1.71917 In Y: 21.286 mm = 0.838 In
W: 48.667 mm = 1.916 In H: 8.094 mm = 0.31866 In

This is the size (W and H) and placement (X and Y) of the first label (rectangle). Please look at the
above image. Please Copy and Paste the Rectangle Frame and place one on the Label in the center
and one in the label to the right.

This is what it should look like, three rectangle frames for the barcodes and three rectangle frames
for the text above. Please look at the above image.



Automation and Data Merge.
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Now it's time to Open the Comma Delimited text file (*.txt) for Adobe InDesign, click on the Windows
menu and then move to Automation and click on Data Merge.

Select Data Source...
Export To PDF

1. Choose Select Data Source from
panel menu,

2. Drag data fields from the pa !
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1|3. Choose Create Menged Doousment from Preview
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I Create Merged Document...

Update Content in Data Fields

Update Data Source

I [ | Preview 4 4 BB o= Content Placernent Options...

This is also known as the Data Merge palette.

In the Data Merge Palette menu, click on Select Data Source. Please look at the image above.

| | 3 Labels one barcode each in InDesign

Select and Open the Comma Delimited text file (*.txt) for Adobe InDesign you have saved earlier.
Please look at the image above.



% DATA MERGE

3 Labek one ba,..in InDesign. bt
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The Data Merge palette shows the possible links to the barcode images and text. Please look at the
above image.

Click on the first rectangle frame as shown in the above image.
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Click on Labell to link it to the rectangle frame.




==Labell==

Select the rectangle frame above the <<Labell>>. Please look at the above image.
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Click on TxtLabell to link it to the rectangle frame. Please look at the above image.
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Now that you know how to link Barcode images and text to a rectangle frame, please link the rest of
them as shown in the above image.
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Let’s change the Font, Font Size, Font alignment and Font color. So please click on the Type Tool (T)
in the Toolbar. Please look at the above image.
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Please select the text as shown in the above image.
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Center the text, click on Align Center as shown in the above image.
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Please change the Font Size to 14 pt as shown in the above image.
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| will select the Font, Arial Rounded MT Bold, please look at the above image.
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| would also like to change the Font color to Cyan, Please click on Swatches and click on Cyan as

shown in the above image.
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That’s it, we have a Cyan 14 pt Arial Rounded MT Bold, aligned center in the rectangle frame. Please

look at the above image.
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==Label2=
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Please make the Font changes to the <<TxtLabel2>> and <<TxtLabel3>> as shown in the image above.
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Please check the Preview so that we can see how it looks on the labels (rectangle). The barcode isn’t
align center, don’t worry, we do that later. Please look at the above image.
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Export To PDF
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Content Placement Options...

Merge all Barcode Images to a document.

In the Data Merge Palette menu, click on Create Merged Document... Please look at the image above.



Let’s use Create Merged Document in Adobe InDesign.
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Please change Records per Document Page: to Multiple Records and also please check Preview

Multiple Record Layout as shown in the above image.
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Create Merged Document
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Let’s center all the barcode images in the rectangle, click on the Options tab and then please check
Center in Frame. Please note that Fitting: is set to Fit Images Proportionally. Please note that is okay
for the small barcode we use. But if you use wider barcodes, | would recommend that you use Fit
Frames to Images. Please click on the OK button. Please look at the above image.
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In the above image you can see how our design will look like.
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All images/pages have been made by Create Merged Document. As you can see we have 300 links, 3
x 100 images. Please look at the image above.
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Print... Ctrl+P
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File menu Print

In the File menu in Adobe InDesign, click on Print to print all the merged documents. Please look at
the image above.
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